
 

 

 

 

© Copyright 2003 - 2017 

Master Business Systems Ltd 
PO Box 467 

Feilding 4740 

New Zealand 

 

Tel  +64 6 323 9483 

Email  enquiries@master.co.nz 

 

 

 

Master Business Systems Ltd © Copyright 2017 All Rights Reserved 

 

GoGet Mobile  

User Guide 

Version 5.12.1 

Effective:  12/12/2017 
 



User Guide GoGet Mobile Version 5.12.1 

Master Business Systems Ltd © Copyright 2017 All Rights Reserved Effective:  12/12/2017 

Disclaimer Statement  

Purpose of this document  

This document describes the functionality and intended usage of GoGet Mobile. 

 

Legal Notice  

The GoGet System and its components are produced and licensed by Master Business Systems 

Ltd.  

 

Copyright  

You must treat the following information, which is the intellectual works and property of Master 

Business Systems, as confidential.  

Master Business Systems Ltd retains copyright to the material contained in this publication.  

You may not reproduce any part of this document or disclose to another party by any means 

without the express written permission of the Managing Director, Master Business Systems Ltd.  

 

Disclaimer  

Master Business Systems Ltd has taken every precaution in the preparation of this document.  

However, Master Business Systems Ltd assumes no responsibility for errors or omissions or for 

damages resulting from the use of the information contained in this document.  
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About the MBS GoGet System 

Key components of the GoGet System 

 The MBS GoGet system consists of a number of applications that provide a complete 

system for building inspection management.  

 

The GoGet system principle is to: 

ü simplify the technical aspects of field inspections 

ü automate the back-end office systems processes 

ü provide an easy-to-use data capture system utilising the latest computer and 

communications technologies 

The key components of the MBS GoGet system are as follows: 

GoGet Office Server 

The Office Server is the core of the GoGet system. 

This is where all consent information is stored and maintained. Generally, it will be located on a 

server within the main office. 

GoGet Call Centre 

The Call Centre provides the opportunity for call centre staff to take bookings for inspections and 

place them on a waiting list. 

Once bookings are on the waiting list, the task of setting up the inspection appointments passes 

across to the schedulers who will then use GoGet Scheduler. 

GoGet Scheduler 

The Scheduler provides an easy-to-follow schedule of each inspectorõs assigned 

consents/inspections and appointments. 
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A team calendar provides a daily overview of the appointments scheduled for each inspector. 

It provides the inspector with the most up -to-date inspection information by co -ordinating the 

loading of data to the Tablet PC. 

GoGet Mobile 

This is the primary application for the Tablet PC. 

Field staff will use it to perform and save results of their assigned inspections taken from the daily 

schedule. 

The Map function is there to provide directions to inspectors to help them find the next 

consent/inspection or appointment. It also offers se arch capabilities and optional GPS functions. 

GoGet Office 

This is the primary application for desktop, in-office use of GoGet. 

This area is for processing consents as well as providing various administration functions and 

features within a single application. 

GoGet Web Service 

This application runs from the GoGet Office server and provides connectivity to the GoGet system 

via Internet/Wi -Fi connection. 

This enables inspectors to perform work remotely using any available wireless or broadband 

connections. 

Inspectors are able to retrieve their schedules and/or individual item information.  They can also 

perform updates back to the Office Server. 

About connectivity in GoGet 

The diagram below illustrates the connectivity options available in the MBS GoGet system. 

The GoGet Mobile application will use whatever method is appropriate to retrieve and update 

information depending on the connectivity available to the Tablet PC.  

Connections via the Internet will utilise the GoGet Local Web Service, unless you have installed 

the optional GoGet Hosted Web Service. 
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Essentially, the user sees no functional difference in the operation of the program other than the 

speed of the transfer of data between the Tablet PC and the GoGet Office Server.  However, 

remote connections to  the Office server are always slower than a direct internal connection. 

 

 
 

About this user guide 

 This guide covers the operational aspects of the GoGet Mobile application, which is part 

of the MBS GoGet system. 

The functionality of the application may c hange from time to time but we make every effort to 

keep this guide up to date.  
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Use GoGet Mobile 

In this section... 

Screen Features ........................................................................................ 6 
Writing Tools .............................................................................................. 9 
Use a Notes Window ............................................................................... 11 
Use the Map Panel .................................................................................. 12 
Use the My Memos Panel ....................................................................... 19 
Use the Mobile Panel .............................................................................. 22 
Use the Schedule Panel .......................................................................... 29 
Use the Office Panel ................................................................................ 31 
Use AutoText ........................................................................................... 35 
Reference Library .................................................................................... 40 

Start the GoGet Mobile program 

 You can start the GoGet Mobile program from the GoGet Mobile icon on the desktop or 

from the Start menu. 

You will need to identify yourself.  This is because GoGet Mobile allows multiple users to share a 

Tablet PC. 

Start from GoGet Mobile icon 

1 Turn on the Tablet PC 

2 Double tap on the GoGet Mobile icon  
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A Please Identify Yourself dialogue box will open. 

 

3 Tap once on your name to select it 

4 Tap on OK 

The GoGet Mobile main window displays. 

Start from Start menu 

1 Tap on the Start button  

2 Tap on GoGet Mobile  on the Start menu 
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A Please Identify Yourself dialogue box will open. 

 

3 Tap once on your name to select it 

4 Tap on OK 

The GoGet Mobile main window displays. 

 

 

Screen Features 

 The GoGet Mobile application is the main program you will use as an inspector.  

You will use it to: 

ü Retrieve inspection data from the GoGet Office Server 

ü Add new inspections out in the field  

ü Perform updates back to the GoGet Office Server 

With this latest version of GoGet, you can use the Tablet PC pen to tap to ôclickõ/select and write 

text entries.  The application makes use of Microsoft handwriting recognition software for text 

entry. 

Other tablets may use touch technology to navigate.  However, you will still use a pen for writing 

text. 
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The GoGet Mobile application is similar to Microsoft Outlook in its style and feel.  It comprises 5 

main parts. 

 

 
 

A  Main Menu 

The main menu is where you can view and modify various options or get assistance in using the 

application. 

At the top level are File and Help. 

The File menu contains: 

ü Option to open different GoGet profiles  

ü Configuration options ð do not change without appropriate permission or instruction  

ü Reprint previously printed Site Notices 

ü Backup (save) the GoGet Mobile database to the Tablet PC 

ü Restore (load) a previously saved database 

The Help menu provides: 

ü Information and guidance on using the application  

ü Information About GoGet Mobile and its current version  

ü Diagnostic Log that lists all processes made by the application within the past 30 days ð if 

you require further assistance with the application, MBS technical support may ask for some 

or all of this information  
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ü Emergency Reset option that clears all data not yet updated to the GoGet office server ð 

please note that all work and settings made prior to updating will be lost if this option is 

selected 

ü GoGet Quick Support ð allows you to connect directly to MBS Support for instant, on -line 

support (See Support) 

 

B  Map Layers and Reference Library 

When using the Map functions panel, the GoGet Mobile system permits you to add and manage 

your own map layers.  You can turn layers off or on by tapping (ticking) the desired layer within 

the list. 

Note:This feature is only available if the maps loaded have the appropriate layers. 

Map layers add more elements and details to the map, such as railway lines and snow landings.  

This allows you to assess an inspection taking into account the regional and environmental factors 

of the property.  

For all other functions, this panel will display a Reference Library.  This can contain various guides 

and documents that you can refer to at any time during an inspection, eg appraisal information, 

product manuals and specifications, etc. (See Reference Library  for more details on page 40) 

 

C  Functions Panel 

The Functions Panel contains 5 items, each of which has its own Working Panel layout and options.  

The first one that you see when you open MBS GoGet Mobile is the Map panel. 

The function panels are: 

Map ð displays the map and related navigation and search tools 

My Memos ð contains consent memos that are loaded onto your device 

Mobile  ð contains all inspection data/information and checklists for the consent/inspection 

currently selected 

Schedule ð contains the daily schedule of inspection appointments 

Office  ð contains functions that interact with the GoGet Office server, eg loading consents onto 

the device, updating saved changes back to the office, etc 
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D  Working Panel 

This is where as a building inspector you will perform most of your work, from choosing an 

inspection to writing and checking memos.  

Select an inspection in the Functions Panel (C) and the Working Panel changes to display those 

particular inspection details. 

 

E  Status Bar 

The Status Bar along the bottom of the MBS GoGet window displays status alerts and information 

about the current state of the application.  This may include any tasks and processes it may be 

loading. 

Some functionality is not available when there is no connection to the GoGet Office server. 

The parts of the status bar are: 

Application Status ð displays any current tasks or processes the application may be loading.  

This will read ôReadyõ when these are complete and the application is ready for use. 

Update Status  ð displays whether there are any Updates Pending (items that need saving back 

to the GoGet Officer Server). 

Connection Status  ð lets you know whether the application has a connection to the GoGet office 

server. 

Office functions become available when the application is ôConnectedõ. 

If you are out in the field or at a remote location such as at home, you can still connect to the 

server through any suitable internet/Wi -Fi connection. 

Version Status  ð displays the current version number of the MBS GoGet Mobile application. 

 

Writing Tools 

 You have a choice of writing tools.  You have a keyboard and you have a notepad.  The 

notepad uses Microsoft handwriting recognition software for text entry.  

Both options are always available in the top left of the window.  
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There is a Tools drop-down menu that allows you to modify the typing/writing settings to meet 

your needs. 

 

 

 

 

You can switch between keyboard and notepad.  Tap on the icon you want to use in the top left 

corner of either window.  

 

Enter text 

1 Tap inside any window or field where you can enter text 

A small keyboard or notepad icon displays.  Which icon displays depends on which writing 

method you used the last time. 
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2 Tap on the icon 

If you want to swap to use the other method, tap on the icon you want in the top left of the 

window 

3 Type or write your text 

4 Tap on the Close button on the keyboard window when you have finished  

or 

Tap on the Insert tab at the bottom right of the notepad window when you ready to 

insert your text and then tap on the Close button when you have finished 

You should insert text frequently when using the notepad to ensure you donõt lose text and 

have to rewrite it. 

 

Use a Notes Window 

 A Notes window displays whenever you need to enter important information regarding 

an inspection item or overall consent. 

This information may be of use to the main Office staff and/or future inspectors.  

 
 

Use the Notes window 

1 Tap inside the Notes window 
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2 Tap on either the keyboard or notepad icon  

3 Type or write your note 

4 Tap on the Close button on the keyboard window when you have finished 

or 

Tap on the Insert tab on the notepad window when you ready to insert your text and 

then tap on the Close button when you have finished  

 

 

 The text you enter in a certain Notes window will only be accessible at that specific 

window. 

For exampleñ 

You enter text within a Notes window for an item at Level 3 of an inspection performance (See 

details under Perform an Inspection  for more details on page 53 (the Inspection tab) for 

information about the different levels).  

You can only access that text by finding and selecting the specific item at Level 3. 

Note You can write notes at Level 3 on checklist items.  You can also write notes at Level 2 on 

inspection types.  However, if you wish to write notes at Level 1, then this must be set 

up in your organisation's profile.  Please talk to a member of the MBS staff if you wish 

this feature to be enabled. 

 

Use the Map Panel 

 The Map panel provides you with a location map of the area you choose to display. 
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There is a toolbar at the top of the map and a status bar at the bottom of the map.  

 

 

The toolbar contains various buttons that allow you to navigate around the map.  

The status bar shows the zoom, scale and map co-ordinates. 

 

 
 

Select 

1 Tap on the Select tool  

 

2 Tap where you want on the map  
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Zoom In and Zoom Out 

1 Tap on whichever Zoom tool you want  

 

2 Tap where you want to zoom on the map 

 

Pan 

Use the Pan tool to drag the map in any direction. 

1 Tap on the Pan tool  

 

2 Tap and hold the pen on the tabletõs screen and drag/draw in the direction you want to go  

 

Centre 

Use the Centre tool to centralise the map on your tabletõs screen. 

1 Tap on the Centre tool  

 

2 Tap where you want the point centred on the screen 

 

From and To 

You can use the From tool to select a starting point and then the To tool to select a destination 

or end point.  
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You may use this to find the most efficient route to your next inspection or appointment.  

1 Tap on the From tool  

2 Tap at your starting point on the map  

3 Tap on the To tool  

4 Tap at the destination or end point on the  map 

 

The map marks the 2 points. 

 

Home 

Tap the Home button to return to the starting position of the map (where it was when you started 

using it). 

 

 

View Default Layer 

Use the View Default Layer  to display all the building consents that have been loaded  onto your 

tablet.  All the consents on your schedule display as blue dots. 
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Note:  This feature is only available if the maps loaded on GoGet Mobile have the appropriate 

building consents layer. 

 
 

Previous View 

Use the Previous View button to return to your previous position on the map.  

 

 

Road Search 

Use the Road Search button to search for a specific road or street within your assigned area. 

 

1 Tap the Road Search button  

2 Write or type the name of the road or street (a few letters will usually do)  
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3 Write or type the specific town (Locality) of the road or street if you need to  

4 Tap on Find 

A list displays containing results relevant to your spelling and wording. 

 
 

Use the GPS function 

 You can use the GoGet GPS function when you select the GoGet Map panel.  It may 

require additional setup on your Tablet PC before you can use it.  Ask a member of the 

IT support team to do this for you.  

 

You will need a connection to the Internet to use the GPS in GoGet Mobile. 

 

Start the GPS in GoGet Mobile 

1 Tap on the Map function panel  

2 Tap the Start GPS button  

 

The button colour will change from blue to green when the GPS is available. 
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An accuracy status (+/- m) will be displayed in the bottom -right of the status bar indicating 

whether you are connected and how accurate (to the metre [m]) the satellite readings 

currently are. 

 

To display your current position within 5 to 10 metres (depending on the amount of 

satellites in rangeñ 

3 Tap the Show Current Position  button  

 
 

Locations 

The Locations button allows you to add and  manage your favourite locations. 

 

When you have a favourite location showing on your mapñ 

1 Tap the Locations button  

2 Tap Add Location  

3 Enter a name for this location 

4 Tap OK 

This favourite location is now available from the Locations drop-down menu. 

 

Relocate a consent 

Use the Activate button and Relocate button to move the current position of the consent (the 

blue dot on the map) to your current GPS position. 
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The current position marker (the blue dot on the map) is located in the middle of the property.  

You may want to relocate this marker to your current location.  

For example, you may be doing an inspection on a farm building that is not central to the property.  

You can move the current position marker to the location of the building.  

1 Tap on the Activate  button  

 

2 Tap on the blue dot for the consent you wish to relocate  

3 Tap on the Relocate button  

 

A Confirmation Required window displays. 

4 Tap on the Yes button if you wish to relocate the selected consent to your current GPS 

position  

 
 

Use the My Memos Panel 

 The My Memos panel allows you to view and access memos addressed and sent 

specifically to you.  You do not see memos to other inspectors. 

However, you will see memos addressed to Next Inspector if you are the next inspector to work 

on a particular consent. 
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 When you complete the Load to Mobile function, all memos and memo responses to 

you are loaded onto the Tablet PC. 

They are available on the My Memos function panel. 

Memos you create and send with GoGet pass through 3 stages: 

Stage 1: The originator (From) creates and sends the memo to the assigned recipient (To) 

Stage 2: The recipient receives and responds to the memo, sending the response back to the 

originator  

Stage 3: The originator receives the response and, once it has been sighted and accepted, signs 

it off to indicate that the recipient received the memo successfully  

You should respond to all memos to let the originator know that you have received and noted 

the contents.  The originator can then sign off the memo.  

The only exception is with Next Inspector memos.  You cannot respond to these. 

 

Find and respond to a memo 

1 Tap on the My Memos function panel (No 1 below)  
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2 Double tap on a memo (No 2) 

3 Enter a response (No 3 below) 

4 Tap on the Save button (No 4)  

Your response is sent automatically to the originator (From) of the memo at the next Update to 

Office you perform. 

 

 
 

Receive a response to your memo 

When you receive a response to a memo you created, a Sign Off button replaces the Save button. 

You need to sign off the memo if you are happy  with the response.  This is confirmation that the 

recipient has seen it and has responded to it.  This completes the third stage in the life cycle of 

a memo. 

1 Tap the Sign Off  button  


































































